
 

 Page 1 of 17 © Aquaveo 

GMS TUTORIALS 

SEAM3D – Chlorinated Ethenes 

SEAM3D also simulates the transport and attenuation of chlorinated ethenes in 

groundwater systems in which either tetrachloroethene (PCE) or trichloroethene (TCE) 

are source compounds.  Because the rate and extent of the biodegradation of chlorinated 

ethenes is dependent on the redox condition, SEAM3D is ideally suited to simulate this 

problem by combining the features of the Biodegration package with the Reductive 

Dechlorination package.  The source compounds (PCE and/or TCE) serve as electron 

acceptors, and the daughter products of reductive dechlorination, cis-1,2-dichloroethene 

(cis-DCE) and vinyl chloride (VC), may serve as either electron acceptors or electron 

donors.  Source terms for chlorinated ethene problems may be implemented using the 

SEAM3D NAPL Dissolution package.  This tutorial illustrates how to use these three 

packages to set up a transport problem for simulating reductive dechlorination under 

variable redox conditions along the groundwater flowpath. 

1 Description of Problem 

The site in this problem represents a shallow unconfined aquifer with a uniform flow 

field from left to right.  A NAPL plume is located on the left side of the model.  The 

NAPL source is comprised of 15% TCE, 15% non-reactive tracer, 25% biodegradable 

substrate, and 45% inert substances.  The tracer, substrate, and TCE are dissolving into 

the ground water and are transported downgradient. 

We will set up a SEAM3D simulation to simulate TCE degradation in an aerobic aquifer.  

With the introduction of the substrate, iron-reducing and also methanogenic conditions 

will develop. The model will include biodegradation, dispersion, and retardation due to 

sorption.  The electron acceptors (oxygen and Fe(III)) and end products (Fe(II) and 

methane) will be modeled using the Biodegradation package.  The gradual release of 

mass from the NAPL plume will be modeled as a source term using the NAPL 

Dissolution package.  The degradation of TCE resulting from reductive dechlorination 

and the subsequent generation and biodegradation of cis-DCE and VC will be modeled 

using the Reductive Dechlorination package. 
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Figure 1-1 Problem to be Solved in SEAM3D Tutorial. 

2 Getting Started 

If you have not yet done so, launch GMS.  If you have already been using GMS, you may 

wish to select the New command from the File menu to ensure the program settings are 

restored to the default state. 

3 Required Modules/Interfaces 

The license registration system used by GMS allows the components of GMS to be 

licensed individually, depending on the needs of the user.  Before continuing, you may 

wish to check whether or not the GMS components used in this tutorial have been 

enabled in the copy of GMS you are using.  This can be accomplished by selecting the 

Register command in the File menu.  On the left side of the Register dialog, the 

following components should have “ENABLED” displayed in the Status column to the 

right of each of the following components: 

• Grid 

• Map 

• MODFLOW 

• SEAM3D 
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4 Importing the Flow Model 

The first step in setting up the SEAM3D simulation is to import the MODFLOW flow 

model.  A steady state flow model has been previously computed and is supplied with the 

tutorial files. 

1. Select the Open button . 

2. In the Open dialog, locate and open the file entitled tutfiles\seam3d\TCE-

flowmod.gpr. 

At this point, you should see a grid appear with contours indicating a uniform flow field 

from the left side to the right side. 

5 Defining the Units 

First of all, we will define the units.  The length and time units will already be set by the 

MODFLOW model.  We will specify the mass and concentration units. 

1. Select the Edit | Units command. 

2. Select the following units: 

Length m 

Time d 

Mass g 

Force N 

Concentration mg/l 

3. Select the OK button to exit the Units dialog. 

The units we have entered are for convenience only and do not affect the calculations.  

GMS displays these units next to the input fields to remind us of the proper units for 

each item.  It is still up to the user to enter consistent units. 

6 Initializing the SEAM3D Simulation 

To create a new SEAM3D simulation: 

1. Select the MT3D | New Simulation command. 

2. In the Model section of the Basic Transport Package dialog select the SEAM3D 

option. 
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6.1 Setting up the Stress Periods 

The next step is to set up the stress periods.  Since none of the sources change over the 

simulation, we can use a single stress period with a length of 7300 days.  For the 

transport step size, we will use 36.5 days.  This forces SEAM3D to compute the 

appropriate transport step size automatically. 

1. Select the Stress Periods button. 

2. Change the Length of the stress period to 7300. 

3. Select the OK button to exit the Stress Periods dialog. 

6.2 Package Selection 

Next, we will select the packages we will be using in the simulation. 

1. Select the Model Setup button in the Basic Transport Package dialog. 

2. Make sure the following packages are selected: 

• Advection package 

• Dispersion package 

• Source/Sink mixing package 

• Chemical reaction package 

• Biodegradation package 

• NAPL dissolution package 

• Reductive dechlorination package 

3. Select the Next button. 

6.3 Defining the Species 

Next, we will define the species used in the simulation. 

1. Set the Number of nondegradable tracers to 1. 

2. In the Microbial Processes section of the dialog turn on the Fe(III) reduction and 

Methanogenesis options. 

3. In the Products to track section of the dialog turn on the Fe(II) option. 

4. Select the Finish button. 
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6.4 Output Control 

We will now edit the Output Control data to specify how frequently the solution data 

should be saved for post-processing.  We will save once every 182.5 days for a total of 

20 time steps over each 3650-day stress period. 

1. Select the Output Control button. 

2. Enter 20 for the Print or save at specified interval. 

3. Select the OK button to exit the Output Control dialog. 

6.5 Entering the Porosity 

SEAM3D requires a porosity value for each cell in order to compute a correct seepage 

velocity for transport.  We will use a constant porosity for the entire grid.  To enter the 

porosity: 

1. Select the Porosity button. 

2. Select the Constant � Grid button. 

3. Enter a value of 0.25 and select OK. 

4. Select the OK button to exit the Porosity dialog 

6.6 Starting Concentrations 

The mobile species are listed in the lower right corner of the BTN Package dialog.  We 

must define a set of starting concentrations for each of the species.  The default 

concentration is zero.  This will be the correct starting concentration for the tracer, 

substrate, chlorinated compounds, ethene, and methane.  However, we must set the 

starting concentrations of the O2, Fe(II), and chloride to the correct background values. 

1. Select O2 in the list and select the Starting Concentration button. 

2. Select the Constant � Grid button. 

3. Enter a value of 4.0 (mg/L) and select the OK button. 

4. Select the OK button to exit the Starting Concentration dialog. 

5. Repeat this process to enter the following starting concentrations: 

• Fe(II) = 0.001 mg/L 

• Chloride = 0.2 mg/L 

This concludes the input for the Basic Transport package. 
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6. Select the OK button to exit the Basic Transport Package dialog. 

7 Advection Package 

Typically, the next step at this point would be to enter the data for the Advection 

package.  However, the default solution scheme (Third Order TVD – ULTIMATE) is 

adequate for this problem and no changes need to be made. 

8 Dispersion Package 

Next, we will enter the data for the Dispersion package.  The aquifer has a longitudinal 

dispersivity of 5 m and a transverse (horizontal) dispersivity of 0.50 m.  The vertical 

dispersivity is assumed equal to the longitudinal dispersivity. 

1. Select the MT3D | Dispersion Package command. 

2. Select the Longitudinal Dispersivity button. 

3. Select the Constant � Grid button. 

4. Enter a value of 5.0 and select OK. 

5. Select the OK button to exit the Longitudinal Dispersivity dialog. 

6. Enter a value of 0.10 for the TRPT value. 

7. Select the OK button to exit the Dispersion Package dialog. 

9 Source/Sink Mixing Package 

The next step is to enter the data for the Source/Sink Mixing package.  This package is 

used to establish the concentration of water entering the system.  For our problem, we 

have water entering the system on the left side of the model through the specified head 

boundary.  We will enter the correct "background" concentrations for fresh water 

entering through this boundary. 

1. Select the Select j tool . 

2. Select the leftmost column of cells. 

3. Select the MT3D | Point Sources/Sinks command. 

4. Turn on the Constant head option for all cells by checking the All row for the 

Constant head column. 
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Once again, the default value is zero.  That is the correct value for most of the species.  

We will change the value for O2, Fe(II), and Chloride. 

5. Select O2 (mobile) from the text window containing the species names. 

6. Enter a value of 4.0 in the All row of the Constant head column.  

7. Repeat this process to enter the following concentrations: 

• Fe(II) (mobile) = 0.001 mg/L 

• Chloride = 0.2 mg/L 

8. Select the OK button to exit the Point Sources/Sinks dialog. 

10 Chemical Reaction Package 

Next, we will enter the data for the Chemical Reaction package.  This package is the 

standard MT3DMS package that is used to simulate sorption and first order decay.  The 

biodegradation reactions are simulated in the Biodegradation package that is unique to 

SEAM3D.  We will use the Chemical Reaction package to simulate retardation due to 

sorption. 

1. Select the MT3D | Chemical Reaction Package command. 

2. Select the Linear isotherm option in the Sorption combo box. 

3. Enter the values shown in Figure 10-2 for Bulk Density and 1st sorption const. 

values for TCE, DCE, and VC. 



GMS Tutorials SEAM 3D - BTEX 

 Page 8 of 17 © Aquaveo 

 

Figure 10-2 MT3DMS Chemical Reaction Package Dialog 

4. Select OK to exit the Chemical Reaction Package dialog. 

11 NAPL Dissolution Package 

We are now ready to enter the data for the NAPL Dissolution package.  For our problem 

we must simulate the gradual dissolution of contaminants from a plume into the 

groundwater.  In MT3DMS, such a situation could be simulated using constant 

concentration cells, injection wells, or recharge.  None of these options results in a 

realistic simulation of dissolution from a plume.  The SEAM3D NAPL Dissolution 

package provides a more realistic representation of a contaminant plume.  With this 

package, we identify the cells containing the NAPL source and enter the initial 

concentration and dissolution rate.  We also enter the initial mass fraction and solubility 

of TCE.  SEAM3D then simulates the release of the each of the species over duration of 

the simulation. 

11.1 Selecting the Cells  

The first step is to select the cells where the plume is located. 

1. Select the Select Cells tool . 

2. Select the Grid | Find Cell command. 

3. Enter 9, 5, and 1 for the I, J, K value respectively and select OK. 
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4. Drag a rectangle to select a 4X2 rectangular region of cells as shown in Figure 

11-3.  The currently selected cell represents the cell in the upper left corner of 

the grid of cells. 

  

Click here 

Drag to here 

 

Figure 11-3 Selecting the Cells Defining the Plume. 

11.2 Assigning the Concentration 

Now that the plume cells are selected the next step is to assign the concentrations to the 

cells. 

1. Select the MT3D | Point Sources/Sinks command. 

2. Check the All row in the NAPL column of the lower spreadsheet. 

3. Enter a value of 0.1 for the Initial conc. for all cells 

4. Enter a value of 1.0 for the Rate dissolved for all cells. 

5. Select the OK button to exit the Point Sources/Sinks dialog. 

6. Click anywhere outside the grid to unselect the cells. 

11.3 Entering the NAPL Data 

Finally, we will enter the remaining NAPL plume data using the NAPL Dissolution 

Package dialog. 

1. Select the MT3D | NAPL Dissolution Package command. 

2. Enter the values shown in Figure 10-4. 
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Figure 10-4 NAPL Dissolution Package dialog. 

3. Select OK to exit the NAPL Dissolution Package dialog. 

12 Biodegradation Package 

The next package to set up is the Biodegradation package.  We will enter the yield 

coefficients, inhibition coefficients, and other reaction parameters controlling the 

degradation of the substrate. 

1. Select the MT3D | Biodegradation Package command. 

12.1 Minimum Concentrations 

Notice that the input for the dialog is broken up into a series of property sheets.  First, we 

will enter the data for the minimum concentrations section.  The default concentration is 

zero.  This will be the correct starting concentration for O2 and Substrate1. 

1. Select the Min. Conc. tab. 

2. Enter 2 for the Number of bio steps per transport step. 

3. Enter 0.001 for the Microcolony minimum concentration. 

4. Enter 5.0 for the Minimum Concentration of Fe(III). 
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12.2 Electron Acceptor Coefficients 

Next, we will enter the Electron Acceptor data. 

1. Select the Elec. Acc. tab in the Biodegradation Package dialog. 

2. For Inhibition Coefficient enter the following values: 

Fe-O2 0.1 

Methane-O2 0.1 

Methane-Fe 25 

3. Enter the following values for the Yield Coefficient: 

O2-Substrate1 0.1 

Fe(III)-Substrate1 0.02 

Methane-Substrate1 0.01 

12.3 Generation Coefficients 

To enter the Generation Coefficient for Fe(II) and Methane: 

1. Select the Gen. Coeff. tab. 

2. Enter 0.10 in the Product Coefficient value for Fe(II). 

3. Enter 0.7 in the Methane Coefficient for Substrate1. 

12.4 Use Coefficients 

To enter the electron acceptor Use Coefficients: 

1. Select the Use Coeff. tab. 

2. Enter the following values for the Electron Acceptor Use Coefficient: 

• O2-Substrate1: 3.5 

• Fe(III)-Substrate1: 35 

12.5 Saturation Constants 

To enter the Saturation Constants: 

1. Select the Sat.Const. tab. 

2. Enter the following values for the Hydro. Half Saturation Constant: 

• O2-Substrate1: 10 
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• Fe(III)-Substrate1: 25 

• Methane-Substrate1: 50 

3. Enter the following values for the Electron Acceptor Half Saturation Constant: 

• O2: 1.0 

12.6 Rates 

To enter the Rate data: 

1. Select the Rates tab. 

2. Make sure that in the Death Rate portion of the dialog the Calculated by model 

option is selected. 

3. Enter the following values for the Max. Specific Rate of Substrate Utilization: 

• O2-Substrate1: 0.5 

• Fe(III)-Substrate1: 0.05 

• Methane-Substrate1:  0.01 

12.7 Starting Concentrations 

At this point, the only remaining data for the Biodegradation package are the starting 

concentrations for the microcolonies and Fe(III).  To enter the Starting Concentration 

data: 

1. Select the Start. Conc. tab. 

2. Select the Edit… button next to Fe(III). 

3. Select the Constant � Grid button. 

4. Enter a value of 50 (mg/kg) and select the OK button. 

5. Repeat steps 2-4 with the following values. 

• Aerobes: 0.25 

• Fe(III) Reducers: 0.025 

• Methanogens: 0.025 

6. Select the OK button to exit the Biodegradation Package dialog. 
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13 Reductive Dechlorination Package 

The last package to set up is the Reductive Dechlorination package.  We will enter the 

reaction parameters controlling the degradation of chlorinated ethenes (TCE, DCE and 

VC) and production of end products (ethene and chloride). 

1. Select the MT3D | Reductive Dechlorination Package command. 

13.1 Minimum and Starting Concentrations 

Notice that the input for the dialog is broken up into a series of property sheets.  First, we 

will enter the data for the minimum and starting concentrations.  The default 

concentration is zero.  This will be the correct minimum concentration for the 

chlorinated compounds, ethane, and chloride. 

1. Select the Concentrations tab. 

2. Enter 0.001 for the Min. concentration for microbe populations. 

3. Select the Edit… button next to PCE/TCE Reducers in the Starting 

Concentration list. 

4. Select the Constant � Grid button. 

5. Enter a value of 0.25 (mg/kg) and select the OK button. 

6. Repeat steps 3-5 for DCE/VC Reducers with a value of 0.025 (mg/kg). 

13.2 Saturation Constants 

Direct oxidation will not be simulated in this problem.  To enter the saturation constants 

for reductive dechlorination: 

1. Select the Saturation Constants tab. 

2. Enter the following values for the Half Sat. Constant for Reductive 

Dechlorination: 

• TCE: 10 

• DCE: 20 

• VC: 15 

13.3 Rates 

To enter the Rate data for reductive dechlorination: 

1. Select the Rates tab. 
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2. Make sure that in the Death Rate portion of the dialog that the Calculated by 

model option is selected. 

3. Enter the following values for the Max Specific Rate of Reductive 

Dechlorination: 

• TCE: 0.1 

• DCE: 0.05 

• VC:  0.04 

13.4 Coefficients 

The default values for the electron acceptor use and methane generation coefficients are 

zero.  These default values will be used, and no data entry is required for these two 

parameter sets. 

1. Select the Coefficients tab. 

2. Enter the following values for the Yield Coefficient: 

• TCE: 0.02 

• DCE: 0.01 

• VC:  0.01 

13.5 Reductive Dechlorination Factors 

The chlorinated ethane stoichiometric factors are preset.  Lastly, we will enter the 

chlorinated ethene data. 

1. Select the Reductive Dechlorination Factors tab 

2. Enter the following values for Chlorinated Ethene Inhibition terms: 

TCE-O2 0.1 

TCE-Fe(III) 25 

DCE-O2 0.1 

DCE-Fe(III) 25 

DCE-TCE 10 

VC-O2 0.1 

VC-Fe(III) 25 

VC-TCE 10 

VC-DCE 1 

3. Select the OK button to exit the Reductive Dechlorination Package dialog. 
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14 Saving the Simulation 

At this point, we are ready to save the model and run SEAM3D. 

1. Select the File | Save As command. 

2. In the Save As dialog, locate and open the directory entitled tutfiles\seam3d. 

3. Enter TCE-run1 for the filename. 

4. Select the Save button to save the files. 

15 Running MODFLOW 

SEAM3D requires the .hff file generated by MODFLOW.  Since we saved the project in 

a different folder than the one where we opened the MODFLOW simulation from, the 

.hff file does not exist in the new location.  We need to rerun MODFLOW so that it will 

recreate the .hff file in the current folder. 

To run MODFLOW: 

1. Select the MODFLOW | Run MODFLOW command. 

2. When the simulation is finished, close the window and return to GMS.  The 

solution is imported automatically. 

16 Running SEAM3D 

To run SEAM3D: 

1. Select the MT3D | Run SEAM3D command. 

2. Select Yes at the prompt. 

3. When the simulation is finished, hit the Close button. 

17 Setting the Contouring Options 

We will now turn on color shaded contours and set up a color legend. 

1. Select the Data | Contour Options command. 

2. Change the Contour method to Color fill. 

3. Select the Color Ramp button. 

4. Turn on the Legend option. 
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5. Select the OK button twice to exit both dialogs. 

18 Viewing the Concentration Contours 

First, we will view the Tracer solution at 7300 days. 

1. Expand the tce_run1 (SEAM3D) folder  in the Project Explorer and select the 

Tracers1 data set . 

2. Select the Time Steps list in the Project Explorer, select the time step at t=7300 

days 

This plot illustrates the concentration contours corresponding to no sorption and no 

reactions.  This is a useful benchmark to consider when viewing the other data sets.  To 

quickly switch between data sets: 

3. Click on the Tracers1 data set . 

This plot (Tracers1) represents sorption but no reactions. 

4. Use the down arrow key to view the other data sets. 

As you view the data sets, compare the travel distance of the tracer to TCE and the 

production of DCE, VC, ethane, and chloride, as well as the consumption of electron 

acceptors and generation of Fe(II) and Methane.  You may wish to use the Time Steps list 

to view the solution at the initial and final time step. 

19 Generating a Time History Plot 

A useful way to compare two transient solutions is to create an observation point and 

generate a time history plot. The fastest way to do this is to create an “Active Data Set 

Time Series” plot. 

19.1 Creating a Time Series Plot 

1. Select the Plot Wizard button . 

2. Select the Active Data Set Time Series option for the Plot Type. 

3. Select the Finish button. 

4. Select a cell in the grid near the contaminant source. Notice that the plot shows 

the concentration v. time. 

5. Select a different cell and notice that the plot updates.  
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If you want to take the plot data and put it into Excel you can right click on the plot and 

select the view values option. This brings up a spreadsheet that you can copy and then 

paste into Excel. 

20 Other Viewing Options 

At this point, you may wish to experiment with other viewing options.  For example, you 

may also wish to set up an animation using the animation command in the Data menu. 

21 Conclusion 

This concludes the tutorial. 


